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User’s Manual for Building the CBMS Database and Poverty Mapping 
 
I. Introduction 
 

This tutorial contains illustrated steps in preparing the CBMS-NRDB for mapping CBMS indicators. Data 
encoded using the CSPro-based encoding system was processed using the CBMS StatSim originally developed by 
the CBMS Network Coordinating Team. The Statsim generates data with specified format ready for import into the 
CBMS Database.  

 
A. Poverty Mapping 
 

 What is Poverty Mapping? 
 

Poverty mapping is the spatial representation and analysis of wellbeing and poverty indicators. As part of the 
CBMS Database, LGUs are able to prepare poverty maps using CBMS data that can show data not just across 
provinces, municipalities and villages but they are also able to show location of poor households.  

 
B. Data Structure for a Municipal CBMS Database 

 
The data structure of the CBMS-NRDB was customized for the needs of the LGUs implementing CBMS. 

This structure is hierarchical so relationship of features should be carefully considered. 
 

 
 

Hierarchy  
- - - - - - - - One-to-one  
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.               . Many-to-one 
 
II. Modifying the Data Dictionary to accommodate CBMS data 
 

The CBMS-NRDB data dictionary provided to the municipalities during the training on digitizing needs to be 
updated to accommodate the data that will be imported into the database. Additional features associated with the 
different geopolitical levels should be added to house the CBMS data generated by the CBMS Indicator Simulator. 

 
To update the Data Dictionary, From the file menu, select Import, Import, File...  

 

 
 
 

The Open dialog is displayed. Select the MDB file “NRDBUpdateTemp.mdb” in the folder 
C:\CBMSDatabase\System\Specs and click on Open.  

 

 
 

The Import dialog will be displayed. Check the box adjacent to the following Features to be updated: 
 

- Household CBMS Demography 
- Household CBMS Core Indicators 
- Household CBMS Other Indicators 
- Purok CBMS Demography 
- Purok CBMS Core Indicators 
- Purok CBMS Other Indicators  
- Barangay CBMS Demography 
- Barangay CBMS Core Indicators 
- Barangay CBMS Other Indicators 
- Municipal CBMS Demography 
- Municipal CBMS Core Indicators 
- Municipal CBMS Other Indicators 
- Provincial CBMS Demography 
- Provincial CBMS Core Indicators 
- Provincial CBMS Other Indicators 
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 Click the button Import to continue.  
 

 
 
 A window indicating the projection will appear. Click OK to continue to start importing the Features.  
 

 
 
Click Save to save the imported Features. The CBMS-NRDB is now ready to hold the CBMS data.  
 

 
 

Please note that updating the data dictionary should only be done once.  
 
 

III. Importing CBMS data from CBMS StatSim 
 

The CBMS StatSim generates tables ready for import into the CBMS database. The tables contain CBMS 
data that has been processed and consolidated at all available geopolitical levels. It is outputted with as a MS 
Access file with specific format compatible with the specifications of the CBMS-NRDB. The files (*.nri) are located in 
the folder C:\CBMSDatabase\System\Specs. 
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The MS Access file that contains the indicators is located in C:\CBMSDatabase\System\Output with file name 
‘Ind_NRDB.mdb’.  This file contains the tables ‘hh_coreind’, ‘purok_coreind’, ‘brgy_coreind’, ‘mun_coreind’, 
‘prov_coreind’, and ‘regn_coreind’ that contain the CBMS core indicators (plus other supplemental indicators) for 
each geopolitical level. 

 
Here are the steps in importing CBMS data: 

 
A. Using NRDB import Format 
 
1. From the File menu, select Import, File...  

 

 
 

2. The Open dialog will be displayed. Select the MS Access file “Ind_NRDB.mdb” in the folder 
C:\CBMSDatabase\System\Output and click on Open.  

 

 
 
 

3. The Import dialog will be displayed. It would show all the tables contained in the file.  The dialog will initially 
check all the tables to prepare for importing.  
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Tables with common appendage “CoreInd” are generated by the Simulator ready for import into the CBMS-
NRDB. This contains the data processed and outputted at the different geopolitical levels (household, purok, 
barangay, municipal and provincial).   

 
4. Click the Load button and browse the folder C:\CBMSDatabase\System\Specs and select the file 

NRDB_ImportSpecs_Core.nri. Click Open button. The nri file is the NRDB import format that saves the 
matching of the Import Columns and Attributes added in the last window.  

 

 
 

When the user highlights a specific table and click the button Define, the import columns and attributes that 
were matched would be displayed. To go back to the previous table, click Next. 
   

 
 

5. A window will appear asking for the date. When all the names have been matched, the Import window below 
will appear asking for the user to encode the date. Default date is the current date. Click the button Next to start 
the importing data. 
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6. After all the data has been imported, the Import Status window will appear. Click on the button Save to save the 
imported file.  

 

 
 

After importing the data, you are now ready to use the data for maps, reports and graphs. 
 

B. Importing data not included in the NRDB import format 
 
1. Repeat steps in III.A.1 to 3.  
 
2. Select a specific table to be imported (example, import demographic data from the Brgy_CoreInd table), then 

click the button Define.  The Select feature dialog will be displayed. Click the pull-down list and select the 
Feature where the table must be imported, in this case, “Barangay CBMS Demography”. Click the button 
Select. 

 

 
 

 The Other half of the Import window will appear. 
 

  
 

3. The Import Columns contains the names of the headings (variable name) found in the table from the MS 
Access file. The Attributes contains the attributes belonging to Barangay CBMS Demography as defined in the 
data dictionary of the database.  
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4. Highlight the matching variables in the Import Columns and Attributes. For example, the variable brgy_tothh is 
matched with the Total Households in the Attributes box. Click the button Add to add the matched import 
column and attribute items to the Import box.  

 

 
 

The following variables correspond:  
 

Import Columns Attributes 
brgy_tothh Total household  
brgy_totmem Total Members 
brgy_totmem_male Total Males 
brgy_totmem_female Total Females 
barangay Barangay [name] 
Municipality Municipality [name] 

 
5. Click the button next and select the next table (example: Purok_CoreInd) and click Purok CBMS Demography 

to import data into. Repeat steps 1-4 with the following specifications: 
 

Import Columns Attributes 
PurokName  Purok [name] 
Barangay Barangay [name] 
Municipality Municipalities [name] 
Purok_TotHH Total Households 
Purok_TotMem Total Members 
Purok_TotMem_Male Total Males 
Purok_ TotMem_Female Total Females 

 
Do the same for the other tables such as: 
 
hh_CoreInd – import data into Household CBMS Demography 

 
Import Columns Attributes 
Barangay Barangay [name] 
Municipality Municipalities [name] 
Brgy_TotHH Total Households 
Brgy _TotMem Total Members 
Brgy _TotMale Total Males 
Brgy _TotFemale Total Females 
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mun_CoreInd – import data into Municipal CBMS Demography 

 
Import Columns Attributes 
Province  Province [name] 
Municipality Municipalities [name] 
Mun_TotHH Total Households 
Mun _TotMem Total Members 
Mun _TotMale Total Males 
Mun _TotFemale Total Females 

 
6. After all the needed variables have been correctly matched, the user has the option to save the import 

specifications as NRDB Import Format (*.nri). To do this, click the button Next>> in the Import window and 
another Import window will appear. Click the button Save. Save as NRDB_ImportSpecs_Demog.nri in the folder 
C:\CBMSDatabase\System\Specs.  

 

 
 

Note: NRDB Import Specifications support multiple feature-table specification; hence a demography import 
specification can handle matching of columns for household, purok, etc. 

 
To call the import format in future activities, click on Load to get the import format.  

 
7. Click the button Import to start the import process. If all the names of the household, purok, barangay and 

municipality matches, the user will be prompted to enter the date. Otherwise, a window “Select Feature Name” 
will open.  

 
For each feature name (e.g. purok, household) found file being imported that does not match one already 
defined in the database the Select Feature Name dialog box is displayed.  
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The options are:  
 
Create – create a new name. The Add Name will prompt you to type the name of the selected feature. The 
default name of the feature is the name that you used and save that polygon while digitizing.   
 
Create All– automatically create names for all, using the default names, do not prompt.  
 
Select - if the spelling is different then the CBMS-NRDB will display the closest match. Click on the Select 
button to accept the match or select one from the list.  
 
Skip – Do not import this feature.  
 
 

8. Follow steps III.A.5 to 6  
 

Below is a summary table for the tables in the Access file to be imported, features where data will be placed and file 
import format that should be used: 

 
table to be imported Feature to hold data 

hh_coreind 
Household CBMS Demography* 
Household CBMS Core Indicators** 
Household CBMS Other Indicators* 

purok_coreind 
Purok CBMS Demography* 
Purok CBMS Core Indicators** 
Purok CBMS Other Indicators* 

brgy_coreind 
Barangay CBMS Demography* 
Barangay CBMS Core Indicators** 
Barangay CBMS Other Indicators* 

mun_coreind 
Municipal CBMS Demography* 
Municipal CBMS Core Indicators** 
Municipal CBMS Other Indicators* 

 
*Import format is NOT provided 
**Import format is NRDB_ImportSpecs_Core.nri  
 
 
IV. Poverty Mapping and CBMS Data Results 
 
A. Adding layers for the CBMS core indicators 
 
1. Click on Map layers and click the button Add. 
 
2. At the barangay level, select the following: 

 
 Under Feature, select Barangay CBMS Core Indicators.  
 Under Name, select the name of your barangay (ex. Brgy. Burgos).  
 Under Display, select Barangay boundaries (polylines/polygons).  
 Under Label, select % of HHs without access to safe water. 

 
Click OK then Click Close to close the map layer window. The map will be displayed. 
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3. At the purok-level, select the following: 

 
 Under Feature, select Purok CBMS Core Indicators.  
 Under Name, select the purok names of your barangay.  
 Under Display, select Purok boundaries (polylines/polygons).  
 Under Label, select % of HHs without access to safe water. 

 
Click OK then Click Close to close the map layer window. The map will be displayed. 

 
                                      

 
 
4. At the household-level, select the following: 

 
 Under Feature, select Household CBMS Core Indicators.  
 Under Name, select the id of all households in all puroks in the barangay.  
 Under Display, select Household location (coordinates).  
 Under Label, select HHs without access to safe water. 

 
Click OK then Click Close to close the map layer window. The map will be displayed. 
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B. Map Layer Properties 
 
The Map Layer Properties has four tabs: 
 
Layer: For data with TYPE Number, use Color Range 
while for TYPE Boolean and Text data, use Separate 
Colour. A space is provided so that the default 
description can be revised. 
 

 
 
 
Style: Modify the Line and Fill Styles for polygons 
and symbols for coordinates (dots). 
 
 

 
 
 
 
 
 

Text: Select “None” from the pulldown list so that the 
labels will not appear in the map. 
 
 
 

 
 
 
Legend: Use Title “<Municipality> CBMS” for all 
maps. 
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C. Color Range 
 
As the objective in CBMS poverty mapping is to show the problematic areas as compared to adjacent provinces, 
municipalities, villages or subvillages, the standard CBMS poverty maps are divided into 4 ranges. To determine the 
ranges in mapping the CBMS Core Indicators: 
 
1. Know the regional/provincial/municipal/barangay data 
 
2.  Sort the data from lowest to highest 
 
3. To determine the cut-offs, the formula below is used: 

 
 
a. Minimum for first range is always zero (0) while the maximum for the fourth range is always 100. 
 
b. Brgy data is the barangay data for the specific indicator. This could be regional, provincial or municipal data 
depending on the geopolitical level that you will map. 
 
c. Min and Max refer to the lowest and highest data 

 
D. Color Scheme 
 
1. Regional, and provincial maps use a green and red color scheme.  
 

Green-colored areas represent data that are above the regional/provincial/ municipal average. Light Green is 
used in mapping data just above the regional/provincial/ municipal average data while a darker shade of Green is 
used for data that is significantly above the regional/provincial/ municipal average data. On the other hand, Pink and 
Red are used for data that are below and significantly below the average.  

 
Below is an example of this scheme on mapping the Proportion of households without access to safe water for 

Province of Occidental Mindoro. The provincial average for this indicator is 17.8%. 
 

Map 1. Proportion of households without access to safe water, by municipality, 2009-2011 
 

 
                            Source: CBMS Census, 2009-2011 
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For this example, the provincial average is used to distinguish between shades of green or red. In this example, 
the ranges used are 

 

 
 

 
 
 

Map 2. Proportion of households without access to safe water, by barangay, 2009-2011 
 

 
 

                        Source: CBMS Census, 2009-2011 
 

The same color scheme is used at the municipal and barangay levels using available data.  
 

2. Purok level 
 

At the purok level, a different color scheme is used. “Shades of blue” color scheme is used in mapping purok-
level indicators. Four shades of blue are used to differentiate data at the purok-levels. The darker the shade of 
blue, the better the performance of the purok. 
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To specify the color scheme: 
 
a. Select the Layer tab, click on the drop-down menu and select Colour Range.  

 
b. Follow the steps discussed earlier in determining the ranges. 
 
c. To add a range, put the minimum value in the box beside Min: and the maximum value in the box beside Max: 

and click Add for every range. 
 
d. Select the Layer tab, click on the drop-down menu and select Colour Range. You can now set your colour 

ranges. (Note: the following ranges may only apply in the case of Brgy. Burgos, Sablayan, Occidental Mindoro). 
 
e. Next, double-click on each of the boxes adjacent to the ranges to apply our color scheme  

 
Hue: 160  
Saturation: 240 
 

 1st Range – Lumens: 120  
 2nd Range – Lumens: 180 
 3rd Range – Lumens: 210  
 4th Range – Lumens: 240 
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f. The following map will be displayed 
 

Map 3. Proportion of households without access to safe water, by purok, Brgy. Burgos, Sablayan,  
Occidental Mindoro, 2009-2011 

 
         Source: CBMS Census, 2009-2011 

 
3. Household-level  

 
Household dots or coordinates use the green and red color scheme. Green represents positive response for a 
particular indicator while red denotes the negative. An example of an indicator is shown below.  

 
To map the CBMS core indicators at the household-level, here are the steps: 

 
a. Add another layer, with the following specifications: 

i. Under Feature, select Household CBMS Core Indicators. 
ii. Under Name, select only the Household IDs in the barangay currently being used. 
iii. Under Display, select Household Location (coordinates). 
iv. Under Label, select HH with no access to safe water. 

 
b. Click OK. The following map will now be displayed  

 
Map 4. Proportion and location of households without access to safe water, by purok,  

Brgy. Burgos, Sablayan, Occidental Mindoro, 2009-2011 

    
 Source: CBMS Census, 2009-2011 
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c. Double-click on the map layer “HH with no access to safe water and the map layer properties will now be 
displayed.   

 
d. Go to the Text tab, click on the drop down menu and select None. Click OK.  
 
e. In order to show which households have access to safe water and which ones have no access, we will adopt 

another color scheme.  
 

• Green Dots ● will represent households with access to safe water while  
 
• Red Dots ● will represent households without access to safe water.   

 
f. The properties of the map layer will now be displayed. Select the Layer tab and then select Separate Style.  
 
g. Next, double click on the dot adjacent to the text: With access to safe water. Under Fill Style, select the green 

color. Click OK. The following map will now be displayed. 
 

 
 
h. Double click on the dot adjacent to the text: Without access to safe water. Under Fill Style, select the red 

color. To emphasize the location of the households, increase the size of the household dots to 3. 
 

                                             
 
i. In the Text tab, choose <None> to remove the labels in the map then click OK and click Close.  
 
j. To show the name of the purok, add another layer “Purok”. In the style tab, choose <None> in the Fill Style. 

Click OK and click Close. Here is the prepared poverty map on proportion of households without access to safe 
water supply in Brgy. Burgos, Sablayan. 

 
 
 

Size should be “3” 
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Map 5. Proportion and location of households without access to safe water, by purok,  
Brgy. Burgos, Sablayan, Occidental Mindoro, 2009-2011 

 

 
                                Source: CBMS Census, 2009-2011 
 
 
The map layouts can be saved to avoid repetition of specifications in the properties of the map layers. Save the 
layout as *.nrm file by clicking File, Save As… After closing the program, the layout can be opened again using the 
saved nrm file. 
 
 
V. Copying the output map to other programs 
 

From the menu bar, click Edit, Copy… to copy the map view. Go to the desired program (i.e. powerpoint file 
or word document) and right-click, paste… to paste the map. To copy the map layer, highlight that area and click 
Edit, Copy… and paste it to the desired file. 
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